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The user interface

I can not use all characters

I can not select and edit this text


Edit scanned files


Text tools: How to work with text

Split and merge files: The pages tabsheet

The virtual keyboard of Text/Change

Copy and paste

How to work with Pictures

Select and move objects, reduce the space between lines.

I can not go back to edit

Security settings, encrypt a pdf file

Bookmarks

I can not open this pdf file

Merge two pdf file

Add comment fields

I can not delete this picture. 

Graphic tools (lines, vector objects)

How to work with this program?

Copy and paste between two different pdf files.

The main menu

How to add a new picture

Open a pdf file
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The user interface. 
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Bookmarks


Bookmarks


Click the Bookmarks tab and use the up/down arrows in the Page field to display the proper page number where you want to set the bookmark.
Click the place you would like to set as a bookmark.

Click on New bookmark to create a bookmark linked to the target area on the page. You can create a child bookmark by setting a new target area, selecting first the parent bookmark, and clicking the New Child Bookmark button. The child bookmark will appear beneath the parent bookmark.


If you want to change the link later you click again into the document, select the bookmark entry in the tree view and click on the green arrow with the hint text: Set to actual page. 
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Why can't I open this file?

Most pdf files will open in PDF Editor, but there are a few that are not supported because they use a syntax that we didn't know of when writing the program. 
Because many users sent us their files, the program now opens most files well. 

If you can not open one of your PDF files please send this file to this email address: webmaster@cadkas.de 

We will fix the problem in the next release.


[bookmark: combinetwofiles]

Can I combine 2 or more PDF files into one?

Yes, open the first PDF file and then go to the Pages tab.
Then click on the menu item Pages/Add pages... to select
the other PDF files. 
You can then change the order of the pages with the blue arrows.
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Comment Tools/Annotations 

There are 3 kinds of comments you can add: Note, Free Text and Stamp. There are also  tools to highlight, underline or strikeout text in the annotation menu. These three commands are text tools, but they are related to annotations and therefore you find them in the annotation menu and not in the text menu. 

To add a new comment, select the annotation tool and click in the document. The pointer tool selects existing annotation. So to select, change, and delete existing annotation fields and hightlighted text, select the Pointer tool and click on a annotation field. 


If you select a comment with the pointer tool, several new options,that were hidden, will appear at the bottom of the page. Here you can enter the text or change the field type. For example, now you can add a stamp.The Delete button will delete an old comment field. 
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With the new Add Link Annotation tool you can add a special kind of annotation which defines an area in the document. If you click an area in Acrobat Reader you are redirected to another page, to a website or to a email adress. The Add link annotation tool does not add text to the document. Use the Text/Add Text tool to add new text for the link, for example, "To the Website". When you have added the visible text part of the link you can define the area of the text or picture with a new link annotation.
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Why can't I delete/move this picture?

In the options menu select the option "Select all kind of objects".
The program provides a function for pictures and
for vector graphics.

If you can not select a picture
with the Picture commands you should try the Graphic
commands instead.

[bookmark: graphics]

Graphics tools



Add graphic objects

You can add graphic objects. This is useful if you want to white out an area on a scanned pdf file. In a scanned PDF file you can not delete text because there is no text information. 

But you can add a white rectangle. Choose the kind of object on in the tool bar at the left side of the main window and the stroke color and fill color in the tool bar at the right side of the main window. If you have selected the right color and kind of object you can start to draw a new object. Click into the document, move the mouse and click again into the document at the end point. 


Delete graphic objects

Select the Delete object tool to delete existing graphics, move the cursor over the object and click on the object to remove it. 
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How to work with PDF Editor



Open PDF file


Double click on the pdf file you want to open under "Open PDF file". 


The program will open the file in the tab sheet "Edit".



Edit


You see a simplified display of the pdf file in the main area.
The Layout and content will be kept after saving. 
If you can not open a file or get a result you can not work with please 
send your pdf file to webmaster@cadkas.de. I continue the improve the
pdf display function of the program.


At the top you find the button "Edit text...". With this function you
will get an overview over all text output and you can change them.


Please note that the text is divided in some parts if there is a command
in the pdf source code which defines a new character spacing for this character.
If a sentence is divided into many parts it can help you to move the text completely
to the first field in order the change the text. The program uses the default
character spacing for good results in most cases.


If you change existing text it may happen that the font does not contain
all the characters you want to use because the font is not completely stored in 
the pdf file. You may have to delete the complete text and add new text with
a new font in this case.



On the right side of the button "Edit text..." you find the button "Edit content...".
You use this button if you want to change the source code of the page directly. You should
download the PDF Reference from the Adobe Website in order to learn the command.
This function is not needed by most customers. 


On the left side you will find a number of tool buttons. With "Comment" you can
insert a commend files which you can place freely.
The settings for the comment field you will find in the bottom area of the window.
Here you can enter the text or change the kind of the field. So you can add a stamp
for example. The program shows the comments only in a simplified version. The see the
stamp you have to open the file in the Acrobat Reader.
The button "Delete..." at the top will delete an old comment field.
You can also underline, hightlight or strikeout text and write an annotation.


With the tool "Text/Add text" you can add new text to the document. Click on the 
place you want to display the text. A dialog window will open and you can
enter the text and change the font and size of the text.
You can use an existing font. But often it is necessary to add a new font because
the existing font may not contain all characters you want to use. 


Use the tool "Text/Change text" to select a part of the text you want to change.
Take also a look at the hints for "Edit text...". 

"Delete text" can delete the text you select with the mouse and click on.


The tool "Picture/New picture" allows you to select an area with the mouse
where a new picture should be displayed. You can select an existing picture
or open a new picture from the hard disk.


With the tool "Picture/Delete picture" you can select a picture with the mouse cursor
and delete it with one mouse click.


Now there are several new tools for moveing and zooming text and pictures freely.
You can use the "Text/Change text block" to edit text as you know it from your
text editor and change the line breaks or insert empty lines.



Pages


Here you can delete pages completely or change there size. You can also hide
the content of a page. The page will display empty until you unhide the content
later. You can also add new pages or extract pages.

Save PDF file


You can now save the changes you made and if you want the program will display
the file in the Acrobat Reader for you.





Information


Change the information which will provided about the author and content of the file.





Security


You can also deside if you want to encrypt the file before saving. You can enter
passwords here.
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Copy and paste between two different PDF files

The copy and paste function only works within one PDF file, but you can combine two PDF files. Open the first PDF file, go to the Pages tab and click Pages/Add pages. Now you can add the second PDF file and make your copy and paste operations. Then you can delete the pages no longer needed. 

[bookmark: menus]
 
Pull-Down Menus



File


	Open...	You can select an PDF file from your hard disk and PDF Editor will open it.
	Save as...	You can save the PDF file with all changes.
	Import...	You can import pictures or word files.
	Export...	You can export as word file, bitmap or text file.
	Create flip pages...	You can create a catalogue with flip pages for your website.
	Print...	You can print the PDF file with all changes.
	Quit	Closes and exits the program.





Edit


	Undo	Undo the last step. 
	Edit texts	Lets you edit all text strings. This command has no "virtual keyboard" and is not usefull for text with own font encoding. You should use the tools Text/Change or Text/Replace text if this command is not usefull.
	Edit content (page source code)...	For most work you can use one of the tools that PDF Editor provides. Edit Content lets you edit the page source code directly. It is the most powerful function in PDF Editor but you need a lot of skill to use it. But you can do almost anything, even functions for which there is no special tool in PDF Editor. 






View

You can set some options for how the pdf file should be displayed here. 


Page

Let you insert blank or scanned pages and pages from another PDF file. 


Selection

Let you edit multiple objects simultaneously 


Language

PDF-Editor is a multi-lingual program. You can choose one of the available translations or even translate it into a new language from this menu. If you want to translate the program into a new language, and you want to provide your translation to other users, please contact us to discuss this issue. 


Help

Provides access to this help file and some other useful information. 

[bookmark: cannotuseallchars]
 
Why I can not use all characters?

You can only use the characters included in the font you currently use, so it is likely that the program that created the PDF file has not included all possible characters. 
If you add new text you have to click Add new font in the Add text dialog box in order to add a new font. You can then type any character with this new font. 

If you want to change text but you can not use all characters then you can also use the Replace text or Text/Font commands. You can also click the Add new font button here. 

You can then write new text in the same position as the old text but with the new font. The Change text function can not change the font. If you want to change the font, use the Change text block function or edit the page source code. 

You always can use Text/Add vector text to add all kind of characters. 

[bookmark: addnewpic]

How to add a new picture?

Choose Picture/Add picture and select a rectangle in the document. The Add Picture dialog box pops up. Click the Add new picture button and load the file from your hard disk. 

[bookmark: open] 
Open PDF file


From the Open PDF File tab, double click the pdf file you want to open. You may also use the Open command from the File menu. 


You may also call PDF Editor from the command line and make the file name you want to open the first parameter. 


The program will open the file in the Edit tab sheet.


[bookmark: cannotgoback]


Once I clicked on pages, I could not go back to viewing/editing. 

Click the Edit tab to go back.
The program has five tabs as follows: 

Open PDF file - this is what you see after starting the program

Edit - this is the main viewing/editing screen

Pages - here you can add new pages, change the order of the pages and so on

Bookmarks - here you can manage your bookmarks

Information - here you can set the title, the creator and the date of the file

Security - here you set if the file is encrypt or not and you password.

Save PDF file - here you can save the PDF file

You can go to any of these work areas by clicking on the tabs shown in this picture:
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Pages


Here you can delete pages completely, change their size and rotate them. You can also hide a page's content. The page will display empty until you unhide the content later. 
 

You can also add new pages or extract pages and add page numbers, headers and footers. 



Combine PDF files/Add pages

Open the first PDF file. Then go to the Pages tab and use the Pages/Add pages command to add other PDF files at the end of the one that is already open. You can then change the order of the pages with the two blue arrows to the right of the list of pages. This is useful if you want to insert one file in the middle of another pdf file. 
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Picture tools



Add Pictures

Select the tool Pictures/Add pics tool. Click in the document, move the mouse and click again at the end point. A yellow rectangle has marked the selected area. 
Now the Add picture dialog pops up and you can either choose one of the existing pictures, or you can load a new picture from your hard disk by clicking the Add new picture button. 


Delete picture

Select the Pictures/Delete picture tool, move the cursor over the picture and click it to remove it. 



Save picture...

Select the Pictures/Save picture tool, move the cursor over the picture and click it. A Save dialog box appears and you can select a folder and filename for the picture. Click Ok to save the picture. 




Move picture

Select the Pictures/Move picture tool, move the cursor over the picture and click it while holding the mouse button down. Move the mouse to move the picture arround and release the mouse button. The picture now has its new position. 



Change size

Select the Pictures/Change size tool, move the cursor over the picture. Click it with the left mouse button to enlarge the picture and click it with the right mouse button to reduce the picture. 


Edit picture

Select the Pictures/Edit Picture tool, move the cursor over the picture and click it with the left mouse button. Now the integrated picture editor ImageArtist will pop up. 
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The Pointer

You can use the Pointer to select annotations, notes, form fields, link fields and document objects like text, pictures, and vector graphics and move them around. Click on an object to select it. You can hold down the CTRL key to select multiple objects, or you can click an  empty space and open a rectangular selection with your mouse. You can then click on the selected objects and move them around. 

[bookmark: copyandpaste]

Copy and Paste

After selecting any number of document objects you can click on Edit/Copy to make a copy of the objects and Edit/Paste to insert the objects on the same page or on another page. You can then move the duplicated objects around. The copy and paste function does not use the Windows clipboard, so it can not be used for data exchange with other applications. 
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Copy and Paste Between two Different pdf Files 

The copy and paste function only works within one pdf file. You can combine two pdf files. Open the first pdf file, go to the Pages tab and click on Pages/Add Pages. Now add the second pdf file. You can now make your copy and paste operations. After you have finished, you can delete the extra pages. 

Save the PDF file

You can now save your changes. You can use the Save PDF tab, use the Save As command in the File menu or click the save icons.
The program will display the file in Acrobat Reader for you if you check the Show PDF File After Saving checkbox.You can also set how the file should appears in your PDF reader.






Information


Change the information which will provided about the the title, the author and the content of the file.
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Security


Decide if you want to encrypt the file before saving. You can also enter passwords here.You can also set restrictions which are active when you encrypt the file. 
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Why can't I edit/select this text?

The text could be a scanned picture or a vector graphic. If it is a scanned file then there is only one picture. There are no text objects. 

Now the the "Scanned Text Editor" is included in PDF Editor. Click on "Text/Edit text on scanned picture" and then click on the picture.



You can use the Picture/Edit picture function and the Clone brush to remove old text. To do this, hold the SHIFT key down, click the background, release the shift key and click the text. The program copies a part of the background over the text and you can add new text with the Text/Add text function. 


[bookmark: texttools]

Text tools

The command Edit Text in the text menu is the same as the command Edit Text in the Edit menu. This tool lets you edit all text. This command has no "virtual keyboard" and is not useful for text with its own font encoding. You should use the tools Text/Change or Text/Replace Text if this command is not useful. Move the cursor over the text to make it  apear red and click on the text to edit it. 

The difference between Change and Change (original text breaks) is that the Change command has a "virtual keyboard" to work with all possible font encodings. In most cases the text strings are longer, because this tool ignores most of the often invisible word breaks that make editing with the other tools a hard job with some files. So the Text/Change tool is the most powerful text editing tool. 


However, in some cases not all characters are available in the font used by the old text. In this case you can use the Replace Text tool instead of the Change Text tool. This tool will delete the existing text and let you add new text in the same position as the old text. 

After clicking on the existing text string, you will see an Add Text dialog box. If you click the Add New Font button you can add a new font to the pdf file. You will then be able to use characters that were not available with the old font. 



If you select the Add text tool and move the mouse you see red lines that show you how the text will be aligned to the existing text. You can hold the [SHIFT] key down if you don't want to align the new text to existing text lines. If you have selected your new text position, click in the document and the Add Text dialog box pops up. You can enter your text in the dialog box. Select the font and if necessary add a new font with the Add new font button. This will ensure the correct font encoding and that all characters are available. 


To delete text you can use the Text/Delete tool. Move the mouse over the existing text so the text will apear red, then click the text to remove it. You can also use the Text/Delete Area tool. Click in the document at the starting point. Move the mouse button. The text in the selected area apears red. If you have selected the right area click a second time to delete all selected text. 


The Highlight, Underline and Strikeout tools are comment tools but they are displayed in the Text menu. Please read more under Comment tool. 



[bookmark: editscanned]

Edit scanned text

If you import a scanned file then there is only one picture with no text objects. 
Now the the "Scanned Text Editor" in included in PDF Editor. Click on "Text/Edit text on scanned picture" and then click on the picture.

You can use the Picture/Edit Picture function and the Clone brush to remove old text. To do this, hold the SHIFT key down, click in the background, release the shift key and click the text to remove it. The program copies a part of the background over the text and you can add new text with the Text/Add Text function. 
[bookmark: virtual]

Virtual keyboard

If the font has a special font encoding and you type in an "a" maybe you will get a "z" or something else.
In this case a virtual keyboard is display at the bottom of the Text/Change dialog. If you click on one
of the gray rectangles this character will be typed. Maybe not all character will exist in the given font. You can
also read the article "Why I can not use all characters?" in the FAQ section of this help file.

[image: ]









[image: ]




		
	Copyright (c) 1998-2024 by CAD-KAS Kassler Computersoftware GbR



	

	










			
		What do you want to do?
                 
	
Edit PDF

	Edit text inside a pdf file
	Create form fields inside a pdf file
	View PDF files and print PDF files
	Scan to PDF
	Create PDF files
	Convert PDF
	Copy content outside a PDF file
	Combine PDF files
	Reorder PDF pages or split PDF
	Make PDF files smaller



Print

	Poster
	Business cards
	Forms
	Calendar
	Photos
	Family tree
	Barcodes



CAD drawings

	Edit dxf files
	Convert to pictures
	Extract lines out of scanned drawings
	Convert PDF to lines
	Convert drawings to PDF
	Convert font/text to lines


	
Documents

	Edit scanned documents
	Print into paper forms
	Create paper forms
	Word Processor



Your company

	Create product catalogs
	Barcodes
	Appointments
	Business cards
	Create logos
	Menu cards



Developer

	Create a autostart CD menu system
	Create EXE files out of your HTML files
	Convert C code to Delphi code
	Create flowcharts



Videos

	Create DVDs
	Cut videos





	
Photos

	Create slide shows
	Effects
	Colorize
	Morphing
	Edit photos
	Manage photos
	Create logos



Music

	Rip music from audio cd
	Convert between music formats
	Fix a scratched audio cd
	Create mobile phone ring tones



Games

	Pool Billiard



Website

	Grab all pictures from a website
	Upload files to a website
	Create a photo presentation website
	Convert websites into EXE files





	
			





                 
			
		Software categories

PDF tools 

CAD tools 

Print & Design 

Business & Office

Photo & pictures

Video & DVD

XPS tools 

Hobbies & fun 

Tools & Utilities 

Internet & Website 

Sound & Music 

Games

Developers 

Complete list
	
			






                 
			
		More information

Does the software run under MAC OS and Linux?



About PDF files



Newsletter



User Opinions



Links



About us


Contact
	
			




